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PREÁMBULO 
 

Esta manual se ha elaborado con el objetivo de apoyar los cursos de formación de usuarios que sobre el 
gestor se imparten en el CRAI Antonio de Ulloa de la Universidad de Sevilla. 
 
El contenido está basado casi en su totalidad en las Guías de Uso del propio gestor que se encuentran 
disponibles en inglés en la siguiente dirección Web http://resources.mendeley.com/  pero además se le 
ha añadido toda la información actualizada desde que se inició la formación sobre el gestor en el CRAI a 
partir del año 2014. Se ha procurado incluir en el contenido aquellas preguntas y/o resolución de 
problemas planteadas en las distintas sesiones de formación.  
 
Para cualquier duda, consulta, error, etc. puede escribir a martas@us.es  o jcsantos@us.es 
 
 
 
 

1. INTRODUCCIÓN 
 

Mendeley es un gestor bibliográfico que permite organizar las referencias y documentos en una 
biblioteca o repositorio personal; editar y anotar documentos  y crear automáticamente las citas y la 
bibliografía en los trabajos académicos con el estilo de cita seleccionado, a partir de las referencias 
recopiladas. Es también una red social de investigadores ya que permite reunirse en grupos,  gestionar y 
compartir referencias y/o documentos en línea, descubrir tendencias y estadísticas en investigación. 

El gestor fue adquirido por Elsevier y durante un periodo, los usuarios de la Universidad de Sevilla tenían 
limitado el espacio compartido y el almacenamiento público y privado. Actualmente Mendeley  es el 
gestor de referencia suscrito por la Universidad de Sevilla y por tanto, tenemos acceso a la versión 
institucional de Mendeley conocida como MIE (Mendeley Institutional Edition). 
 
Las diferencia entre ambas versiones de Mendeley, las podemos ver a continuación pinchando en el 
siguiente enlace http://www.elsevier.com/online-tools/mendeley/about#about-mendeley-
institutional-edition. 
 
En palabras de Julio Alonso Arévalo en Mendeley hay fundamentalmente científicos de las áreas 
aplicadas y de las Ciencias Puras, aunque se van incorporando también de otras áreas como las 
Humanidades, Sociales y Psicología. Es una comunidad que ha ido creciendo y ya alcanza a más de 
4.000.000 de usuarios en todo el mundo.  

 

 

 

 

 
 



 

 

Las características principales de Mendeley son las siguientes: 
 

 Combina una versión Web con una versión Escritorio. Su coexistencia permite al usuario trabajar 
desde cualquier ubicación accediendo a la base de datos personal y a los materiales 
almacenados en su espacio en la “nube”, en los servidores de Mendeley. Desde ambas se 
pueden gestionar las referencias recopiladas por el usuario. 

 Incorpora funcionalidades de la Web 2.0: es una red social y permite crear Grupos, compartir 
referencias y/o documentos con colegas. Gestión de identidad digital. Plataforma de 
descubrimiento. 

 Proporciona métricas: da visibilidad a nuestra producción científica. Podemos conocer las 
referencias que más se han compartido. Será un indicador de reputación digital. 

 Captura referencias de sitios Web mediante la herramienta “Web Importer”. 
 Extrae de forma automática los metadatos de los ficheros PDF incorporados a la biblioteca y 

genera las referencias correspondientes.  
 Incorpora un Visor de PDF que permite trabajar en línea con ellos: recuperarlos, leerlos y 

anotarlos. 

 Genera citas y referencias con Microsoft Word, Libre Office, and Látex. Puede utilizarse con 
Mac, Windows y Linux.  

 Y en relación con la característica anterior, se puede utilizar con dispositivos móviles (iPhone o 
iPad). Es compatible con los sistemas operativos más comunes (Windows 7, 8, Vista y XP, Mac 
OS X 10.5 o posterior, Ubuntu o Debian Lenn y distribuciones de Linux),  y puede manejarse 
tanto en  ordenadores de sobremesa y portátiles, como dispositivos móviles, teléfonos y 
tabletas. 

 Permite crear un perfil profesional de investigador y compartir publicaciones, premios y 
conferencias.  

 
Es, en definitiva, un gestor de referencias adecuado para aquellos Investigadores que quieran ganar 
Visibilidad. 
 
1.1. Creación de Cuenta e Instalación de Desktop en nuestro ordenador. 
 
- Accedemos a la página de Mendeley y creamos una cuenta con nuestra dirección de correo 

institucional, cumplimentamos los datos requeridos y descargamos e  instalamos  Mendeley versión  
Desktop en nuestro ordenador. Si creamos la cuenta con la dirección de correo institucional, 
automáticamente y una vez que accedamos al programa desde la Web de la Institución, la versión 
MIE será automáticamente activada.  

  



 

 

 
  
- El perfil personal en Mendeley puede cumplimentarse en este momento, especialmente en lo que se 
refiere al campo de interés de investigación, que servirá al sistema para operaciones posteriores, 
ofreciendo documentos relacionados con dicho ámbito. 
 

Antes   de   empezar   a   trabajar   con   Mendeley debemos   conocer   algunos aspectos 
fundamentales: 
 
 

 Cómo exportar referencias desde otros gestores. 
Desde Refworks a Mendeley http://guiasbus.us.es/ld.php?content_id=3048765 
 

 Sincronizaremos la versión Web con la Versión Escritorio. Esta acción es permanente. En 
algunos momentos puede ser conveniente hacer clic en este botón para comprobar de manera 
inmediata que el programa está trabajando correctamente y se sincroniza con la versión Web.  
 
 Es importante tener en cuenta que cuando utilicemos la versión escritorio, si nos sale algún 
mensaje de actualización de la versión de Mendeley, debemos instalarla para que todo funcione 
correctamente.  
 
 Mendeley está desarrollando y mejorando el acceso a “Mi Biblioteca” desde la Web y la 
tendencia que se observa es que se asemeje cada vez más a la versión Escritorio. La última de las 
Novedades es que la gestión de los Grupo, que antes se llevaba a cabo en la versión Escritorio ha pasado 
a la Web.  
 
 
 



 

 

  
 
 
 
Por último, mencionar que la interfaz de usuario del programa de gestión del préstamo 
interbibliotecario [http://pibserver.us.es/gtb/menu_usuario.php?centro=%24USEG] de la Biblioteca de 
la Universidad de Sevilla permite la exportación de citas a Mendeley. En la siguiente imagen podemos 
ver un ejemplo. (Este botón también está integrado en el catálogo FAMA). 
 
 

 

 Accede ahora mismo al tutorial “Exportar a Mendeley desde la Lista de Peticiones de Préstamo 
Interbibliotecario” 
 
https://www.youtube.com/watch?v=bFui3drY1Pg&index=11&list=PL- 
nGR3dgPXExCiBuifCmApHo0WpTMQgM1 
 
 
Podemos afirmar, que Mendeley es un gestor en continuo desarrollo y esto nos obliga como 
Profesionales de la Información al estar al tanto de todas las novedades y problemas que surjan.  
Resumimos algunos de los cambios surgidos a lo largo de estos años:  
 

 Un nuevo perfil de investigador. Cambia la funcionalidad y la visibilidad. Será más fácil de 
actualizar y permitirá descubrir los logros más importantes de un solo vistazo. 

 Integración de Scopus. Será más fácil agregar datos desde Scopus a Mendeley. 
 Nuevas estadísticas en Mendeley. El investigador va a disponer de estadísticas más completas 

con vistas a que pueda evaluar mejor el impacto de sus publicaciones. 
 Se ha implementado el botón “Save to Mendeley” para Chrome. 
 Nuevas opciones en Mendeley web. Datasets, Careers y Funding.  

 
Desde el siguiente enlace, se puede estar al tanto de las distintas actualizaciones de Mendeley, así como 
el objetivo de las mismas.  
https://www.mendeley.com/release-notes/development/ 
 

Importante: Una vez finalizado este curso y puesto que estamos utilizando ordenadores 
públicos, haremos clic en Help > Reset. De esta forma no se guardará ningún dato en local y 
evitaremos que alguien pueda acceder a nuestra información. 

 
NO OLVIDAR DESCONECTAR SESIÓN EN: File > Sign out 



 

 

 
 
 
 



 

 

 

2. MENDELEY: VERSIÓN ESCRITORIO 

 
2.1. Interface 

Desde la Versión escritorio tendremos todos nuestros documentos almacenados y organizados desde 
un solo lugar. Es el lugar desde donde controlaremos todas las operaciones en Mendeley. La interfaz 
de Mendeley es clara e intuitiva. A continuación en la imagen veremos el aspecto que presenta la 
interfaz.  

 

Las principales opciones en la versión escritorio son: 
 
a. My library: proporciona acceso fácil a tu biblioteca, publicaciones, carpetas y grupos. 
 
b. Sync: Para sincronizar tu base de datos en los distintos dispositivos de forma que puedas acceder 
a tu base de datos de referencias desde cualquier lugar. La sincronización salva y actualiza todos los 
datos y permite su recuperación en la versión Web, almacenándolos  en el espacio personal en la 
nube. 
 
c. Visor de PDFs: Haz doble clic en un documento para que se abra en el Visor de PDF. El visor de 
PDF te permite leer, subrayar (“Highlight”), buscar, anotar (“Note”), y mucho más con las opciones 
avanzadas. Puedes además realizar anotaciones de forma colaborativa si haces clic dentro de un 
Grupo Privado en “Synchronization File” para los archivos adjuntos. Se pueden añadir Notas 
generales (“Global notes”) que además pueden recuperarse. Usa “Keyword search” para buscar 
documentos por palabras claves o frases. 
 
d. Details panel: Visualiza los detalles de cada documento para añadir de forma rápida metadatos y 
notas. 
 



 

 

e. Search: La cajetilla de búsqueda si te posicionas en All Documents o una carpeta busca sobre 
dichos elementos. También puedes usar la cajetilla cuando actives el visor de PDFs y entonces podrás 
buscar sobre el texto completo del PDF. 
 
f. Literature Search: para localizar documentos dentro de la base de datos de Papers de Mendeley. 
 
g. Mendeley Suggest: ejemplo de cómo Mendeley trabaja como Plataforma de descubrimiento y te 
sugiere documentos que pueden interesarte de acuerdo a tu experiencia con Mendeley. Previa 
activación, realiza una búsqueda ajustada a los parámetros del perfil de usuario y las referencias en la 
cuenta, merced a un algoritmo “inteligente”. Las referencias obtenidas pueden incorporarse a 
nuestra base de datos. 
 
 

 
 
Mendeley Suggest desde Mendeley Web 
 
 
 
Otras opciones a destacar son: 
 
- View: Ver como Documento o como Cita. 
- Tools: aquí se encuentran los Plugins. Destacamos dos que tendremos que instalar: Web 
Importer y el plugin de Word. 
- Help: Disponemos una opción de crear copia de seguridad. Crear > Backup. 
- Needs Reviews: cuando una referencia esté incompleta automáticamente Mendeley crea 
una carpeta donde guarda estas referencias que necesitan revisarse. Esta carpeta también aparecerá 
en la versión Web. También manualmente podemos marcar una referencia con botón derecho del 
ratón como elemento que necesita revisarse. Al mostrarnos el listado de documentos con posibles 
conflictos nos permite su edición y que queden subsanados los posibles errores.  
- Mendeley incorpora una Papelera donde van a parar los registros que borramos de 
nuestras carpetas.  El borrado se puede hacer desde las líneas de menú o marcando un registro o 
conjunto de registros, pulsando el botón derecho del ratón y seleccionando la opción Delete 
documents, si estamos en la carpeta All Documents, o bien Remove from Folder, si estamos en otra 
carpeta de rango inferior. En este último caso, el registro se borra solamente de la carpeta afectada. 
En caso de estar en la carpeta All Documents, se borra de la base de datos, es decir, de All 
Documents y de cualesquiera otras carpetas donde estuviera incluído. No obstante, si accedemos a la 
carpeta Trash/ All Deleted Documents podemos ver los documentos borrados y seleccionar uno o 
varios más el botón derecho del ratón y restaurar los registros a la base de datos, o borrarlos de 
manera definitiva, sin posibilidad de recuperación. 
 



 

 

 
Vista global del Interfaz de la versión escritorio 
 
 
  

 
 
Detalle de la opción Needs Review 
 
 
 

- Merge Documents: Fusión de los documentos marcados en uno solo. 
 

- Delete Documents: Borra los documentos seleccionados. 



 

 

- Remove from Folder: Borra los documentos de la carpeta, pero no de la base de datos.

 

- Rename Document Files: Renombra los ficheros en los campos seleccionables, moviendo 
las opciones cambiando el orden de cada bloque o borrándolos. 

 

 

 

 

 

 
- Sincronize Library: Sincronización/actualización de datos en el espacio del usuario en 

los servidores de Mendeley. 

 
- Sign Out: Desconectar del servidor y terminar la sesión. 

 
- Quit: Salir del programa. 



 

 

 

 

A continuación vamos a analizar las distintas opciones que podemos encontrarnos bajo los 
principales Menús de Mendeley Escritorio.  

MENÚ EDIT 

 

 

Undo. Deshacer, anular la última acción. 

Redo. Rehacer la última acción anulada. 

Find. Encontrar el término buscado en la base de datos personal. También está disponible en el 
cajetín Search. Permite hacer una búsqueda de cualquier elemento en referencias o 



 

 

documentos, que aparezca en la cabecera o en el texto, notas, etiquetas, palabras clave, etc. 

 

 

Es una potente herramienta que nos permite filtrar por términos, complementando la función 
de Filtro que afecta a autores, palabras clave de autor, etiquetas, y títulos de publicaciones. 

Export. Exportar una o varias referencias seleccionadas en un fichero de extensión .bib 
 
Send by E-mail. Enviar por e-mail los ficheros marcados. Esta opción ya no está disponible en las 
últimas actualizaciones de Mendeley.  
 

 



 

 

 
 
 

 
 
 
Cut, Copy, Paste. Funciones habituales en cualquier software para cortar, copiar y pegar. 
Copy  as. Permite copiar el texto seleccionado como una Cita Formateada, un Comando de Cita 
para LaTeX o una Entrada BibTeX. 



 

 

 
 
Cita Formateada 
Arrington JM, Kubitzki K. Flowering Plants Dicotyledons: Malvales, Capparales and Non-betalain 
Caryophyllales. In: Kubitzki K, Bayer C, editors. Berlin, Heidelberg: Springer Berlin Heidelberg; 
2003. p. 62–70. Available from: http://dx.doi.org/10.1007/978-3-662-07255-4_15 
 
 
 
 
Comando de Cita para LaTeX 
\cite{Arrington2003} 
 
Entrada de BibTeX 
@inbook{Arrington2003, 
address = {Berlin, Heidelberg}, 
author = {Arrington, J M and Kubitzki, K}, 
chapter = {Cistaceae}, 
doi = {10.1007/978-3-662-07255-4_15}, 
editor = {Kubitzki, Klaus and Bayer, Clemens}, 
isbn = {978-3-662-07255-4}, 
pages = {62--70}, 
publisher = {Springer Berlin Heidelberg}, 
title = {{Flowering Plants Dicotyledons: Malvales, Capparales and Non-betalain Caryophyllales}}, 
url = {http://dx.doi.org/10.1007/978-3-662-07255-4{\_}15}, 
year = {2003} 
} 
 
Select all. Marca todos los ítems. 
 
 
 
 
 
 



 

 

La última parte de esta sección afecta a tareas referentes a Carpetas y a Grupos: 

 
New Folder. Crea una carpeta nueva. 
New Group. Crea un Grupo nuevo. 
Rename Folder. Renombra una carpeta. 
Remove Folder. Borra una carpeta. 
 
 
MENÚ VIEW 
 
Afecta a la presentación en pantalla de diversos ítems. 
Las dos primeras opciones, nos permiten conmutar la presentación de nuestra biblioteca de  
referencias bien como Tabla, bien como Cita bibliográfica. 
 
Library as Table. 

 
 
 
 
 
 
 
 
 
 



 

 

Library as Citation. 

 
 
El usuario puede conmutar la presentación a voluntad, según su interés en el momento del 
trabajo. No obstante, puede ser determinante que los cambios en los Estilos de Cita, que se 
eligen en la siguiente opción, sólo se hacen patentes cuando estamos en la presentación en 
modo Library as Citation. 
 
Citation Style. Uno de los aspectos más atractivos de un Gestor Bibliográfico es la capacidad de 
trabajar con los Estilos de Cita. Como se aprecia, en primera instancia Mendeley ofrece algunos 
de los estilos más comunes  en diversos campos de actividad científica.  

 
 
En caso de no encontrar en esa lista el estilo deseado se puede acceder a un repertorio más 
extenso picando More Styles. 
Esta ventana presenta los Citation Styles actualmente instalados en nuestro escritorio así como 
otras opciones, Get More Styles, Abbreviations, About. 
Installed. Por un lado nos permite ver cada estilo de la lista y comprobar si hay actualizaciones 
disponibles. 



 

 

 
 
Asimismo, nos permite elegir si queremos que se adjunten las URL y fechas de acceso en las 
bibliografías, para todos los documentos o sólo para las Páginas Web. 
Y, muy importante, el Idioma que manejamos en nuestro texto, para adecuar los términos que 
aparezcan en las citas bibliográficas. 
 

 
 
 
Get More Styles. Si precisamos un estilo de cita que no está instalado podemos buscarlo 
tecleando los datos disponibles en el cajetín. A medida que vamos escribiendo nos presentará las 
coincidencias encontradas en la lista del Repositorio de Estilos de Mendeley y ofrece la posibilidad 
de descarga e instalación. 



 

 

 
 
Podría darse la circunstancia de que el estilo deseado no apareciera en la lista pero tuviéramos 
referencia del mismo con su URL que apuntase al registro correspondiente en el Repositorio. Esa 
URL se introduciría en el cajetín inferior para solicitar la descarga del Estilo de Cita. 
 
Abbreviations. Configura la forma de aparición de los títulos abreviados o desarrollados de las 
Publicaciones. En el siguiente tutorial puede conocer mejor su  funcionamiento.  
 

https://www.youtube.com/watch?v=Wm8RZCWmR04&index=50&list=PL-nGR3dgPXExCiBuifCmApHo0WpTMQgM1 
 
 
 
 
 
 



 

 

 
 
About.  En casi todos los programas que usamos apenas prestamos atención al ítem About. Sin 
embargo, en Mendeley, es un interesante recordatorio de lo que se ofrece sobre estilos de cita y 
sus enlaces de acceso. 
 

 
 
A través de ellos podemos acceder al Repositorio donde hay más de 8.000 registros en abierto, 
para elegir aquel estilo que más cuadra con nuestras necesidades. Y si no lo encontramos a 
nuestra medida es posible seleccionar el que más se parezca y modificar campos y 
características para obtener un estilo personalizado. 
 
 



 

 

Entre las últimas opciones del Menú View  encontramos las referidas a lo que se muestra en 
pantalla, Toolbar Layout/Show text, Show Documents Details y Mendeley Suggest. 
 

 
 
Toolbar Layout. Nos permite mostrar/ocultar el texto que acompaña a los iconos que aparecen 
en la segunda línea de menú, Add Files, Folders, etc. 

 
 
Show Documents Details. Nos permite mostrar/ocultar  la ventana vertical que aparece en la 
parte derecha de la pantalla y que contiene tanto los Detalles de cada referencia que se muestra 
en la parte central de la pantalla, como las Notas escritas por el usuario y otros contenidos. En 
caso de no precisar edición de los detalles de las referencias podemos ocultar esa sección, 
ganando espacio para la revisión de nuestra base de datos. 

 
 
 
 
 
 
 
 
 



 

 

MENÚ TOOLS 
 

 
 

Invite Colleagues. Mendeley no solo facilita el trabajo personal a la hora de gestionar referencias y 
documentos sino que cumple una importante función como red social científica, escaparate de 
nuestro trabajo y herramienta de relación y contacto. Mediante esta opción podemos invitar a 
otros investigadores a sumarse a la comunidad de Mendeley. El sistema nos pide entrar en nuestro 
espacio en la versión web y desde ahí enviar un mensaje por e-mail a cuantos usuarios 
consideremos. 

 
 
Install Web Importer. Mendeley proporciona plugins para trabajar con los navegadores más 
usuales a fin de capturar referencias para nuestra biblioteca. Se accede a la instalación desde el 
ítem Tools. Al seleccionar la opción nos lleva a la página de soporte técnico de Mendeley 

 



 

 

 
 
En ella habremos de seleccionar el plugin según nuestra preferencia por un navegador u otro y 
seguir las instrucciones de instalación. 

 
 
Install MS Word Plugin. Permite trabajar con los siguientes Procesadores y Formatos: Windows 
Word 2007, 2010, 2013; Mac Word 2011 ; LibreOffice y BibTeX. 
 
 
Check for Duplicates. Mendeley nos permite revisar nuestra biblioteca, completa o por carpetas, 
para detectar registros duplicados, bien sean sólo referencias o el tándem referencias-
documentos. 

 
El sistema nos muestra los registros que parecen estar duplicados y nos da la opción de unirlos en 
uno solo. 
 
Options: 
General. Nos muestra datos del uso de nuestro espacio en los servidores de Mendeley, espacio 
usado en almacenamiento y espacio compartido en grupos. 



 

 

 
 
 
Document Details. Configura los datos a extraer/gestionar por el sistema de cada documento, 
según la tipología del mismo.  

 
 
File Organizer. Gestiona diversos aspectos de configuración en el uso y almacenamiento de 
ficheros en carpetas y subcarpetas de nuestro ordenador así como renombrado de ficheros  



 

 

 
usando para ello las etiquetas que designemos. 
 
 
 
Watched Folders. Permite configurar la carpeta o carpetas que queramos que actúen como 
Carpeta “centinela”. 



 

 

 
 
 
BibTeX. Configura el sistema para aquellos usuarios que deseen usar LaTeX. 

 
 
 
 
Zotero.- Permite configurar el sistema para sincronizar la cuenta de Mendeley con una base de 
datos previa de Zotero. 



 

 

 
 
 
Connection.- Configuración de conexión. 

 
 
 
Help: 
Help Guides. Conecta con la web de Mendeley y muestra opciones de ayuda. 
Mendeley Website. Conecta con la web de Mendeley http://www.mendeley.com 
Support. Conecta con http://support.mendeley.com/ donde puede navegar por las 
FAQ de Mendeley, plantear preguntas y pedir asesoramiento. 
 

 
 
 
 



 

 

Check for Updates. Buscar actualizaciones del programa, si hubiere. 
Create Backup/Restore Backup. Generar /restaurar una copia de respaldo de nuestra biblioteca. 
Reset Mendeley Desktop. Elimina cualesquiera ficheros temporales que se hayan creado en el disco 
duro del ordenador durante el desarrollo de la sesión. Es conveniente usar esta opción siempre que 
estemos trabajando en un ordenador público. 
About Mendeley Desktop. Ventana de información sobre copyright y marcas de Mendeley. 
 
 
 
 

2.2. Añadir documentos a tu Biblioteca 
 
 

Permite incorporar los documentos hasta de 6 formas distintas. 
 
En Mendeley podemos añadir documentos a nuestra Biblioteca usando los siguientes 
procedimientos: 

 
 
a) Desde File > Añadir una referencia manualmente. Practicaremos añadiendo un libro (Book). 
Esta opción nos permite hacer una búsqueda a través de identificadores, como DOI, arXiv ID, 
PMID, etc. En caso de conocer cualquiera de estos identificadores puede correrse una búsqueda e 
incorporar la referencia encontrada. 

 
b) Add Files: Añadir ficheros de forma individual. Se despliega el árbol de directorios para navegar 
por él y seleccionar el fichero que deseamos incorporar a nuestra biblioteca. 
 
c) Add Folder: Añadir ficheros marcando una Carpeta. Se despliega el árbol de directorios y se 
señala una carpeta, todos los ficheros que contenga se incorporan a Mendeley. 
 
 



 

 

d) Drag and drop files or folders: Permite arrastrar archivos o carpetas y guardarlos de forma 
rápida en la Ventana de Mendeley. Estos archivos podemos recuperarlos en la carpeta “Recently 
Added” en el panel del lado izquierdo. Además Mendeley permite incorporar tanto PDF como 
archivos RIS. 
 
 
e) Importar referencias desde otras fuentes de información. Desde este enlace podremos 
conocer qué fuentes de información funcionan con Web Importer e incluso proporciona 
información a los proveedores de cómo conseguir que funcione en sus bases de datos. 
http://www.mendeley.com/import/ 
 
 
f) Importar referencias desde otro software de gestión bibliográfica. 
 
Podemos Importar ficheros en varios formatos/procedencias. 

- BibTeX. Ficheros de texto formateado, extensión .bib 
- RIS. (Research Information System) Fichero de texto formateado, extensión .ris 
- EndNote. Importación desde el gestor bibliográfico EndNote. 
- Zotero Library. Importación desde el gestor bibliográfico Zotero. 

 
Para ello hacemos clic en File > Importar y seleccionamos el archivos a exportar. Es posible 
transferir nuestras referencias desde gestores como EndNote, Papers de Mendeley, Zotero, 
Refworks, Jabref y otros. 
 



 

 

 
 
Además en Mendeley se puede añadir documentos mediante el DOI, incluyéndolo en  el campo 
correspondiente. 
 
 
g) Añadir tus publicaciones. En la carpeta “Mis Publicaciones” podemos arrastrar y guardar 
nuestras Publicaciones y compartirlas con otros investigadores desde la Versión Web, autorizando 
como autor la descarga. De esta forma conoceremos qué investigadores han visto nuestras 
Publicaciones. Conforma la base de datos de Mendeley, accesible desde Papers en la versión Web 
y Literature Search en la versión Desktop. 
 
 

 
 
 
Además, es importante destacar que los documentos que guardamos en My Publications se 
recuperan desde Google Scholar, lo cual es muy interesante si queremos dar a conocer nuestra 
producción científica. 

 

Es importante destacar dos opciones para controlar el trabajo que hacemos con las referencias 
y/o documento añadidos, como son los siguientes: 

- Recently added. Ojo, no eliminar los documentos aquí almacenados. Se eliminan 
automáticamente cada 14 días. Si una referencia en esta carpeta aparece con el punto 
verde quiere decir que no se ha guardado en ninguna carpeta. En el momento que lo 
hagamos, podremos desmarcar el punto verde y así sabremos que esa referencia ya 
está incluida en su carpeta correspondiente. 

- Recently read. Sirve para saber los últimos documentos que hemos visualizado en 
PDF. 

 
Importante: La opción de "unpublished work-exclude from Mendeley web catalog" se refiere a la 
referencia bibliográfica completa y con ello se informa que ese trabajo está pendiente de 
publicación y que, por el momento, no deseas que se vea esa referencia en el catálogo. Esta 
casilla podemos activarla dentro del panel de detalles de cada referencia en nuestra biblioteca. 



 

 

Podemos probar esta opción buscando nuestros propios documentos en Mendeley y, en caso de 
apariciones, incorporarlos ya a nuestra biblioteca y a la correspondiente carpeta, My Publications. 
 
 
 
 

 



 

 

 
 
2.3. Organizar tu biblioteca y buscar documentos 
 

Mendeley permite recuperar los documentos buscando en tu biblioteca, en el texto completo de 
los documentos e incluso en la Notas y etiquetas (“tags”) creadas por uno mismo. 
 
Se puede además filtrar por distintos criterios de búsqueda, como podemos ver en la imagen 
incluida a continuación. Podemos aplicar estos filtros a todas las referencias o a las de una carpeta 
concreta si nos posicionamos en ella. Podemos gestionar la visualización de referencias filtrando 
las mismas por diversos ítems: autores, palabras clave de autor, etiquetas y publicación. 

 
 
 
Las referencias que cumplen la condición especificada en el filtro nos aparecen en la columna 
central. 
Los filtros nos permiten también detectar duplicados o formas incorrectas de escritura en alguno 
los campos, marcar la entrada incorrecta y arrastrarla sobre la correcta, y validar el cambio tras la 
petición de confirmación. 
En este caso “Rodriguez-Santos” y “Rodríguez-Santos, Juan Carlos” son el mismo autor y puede 
refundirse en una sola entrada. 

  
 
 
 
   
 
 
 
 



 

 

 
 
 
Para crear Carpetas y Subcarpetas tan sólo hay que hacer clic con el botón derecho del ratón en 
el panel izquierdo. Podemos arrastrar y mover archivos de una carpeta a otra. También podremos 
crear carpetas con los iconos directos. 

 
 
Se pueden asignar etiquetas a nuestros documentos de manera fácil desde el panel de detalles de 
la derecha, tal y como podemos ver en la siguiente imagen. 
 
 

 



 

 

 
Ejemplo de una Carpeta organizada por capítulos. Podremos crear carpetas y subcarpetas, 
posicionándonos en una carpeta concreta y añadiendo otra nueva. 
 

 
 
Imagen: Carpeta Unsorted que incluye referencias que no han sido asignadas aún  a ninguna 
colección/carpeta. 
 

2.4. Leer, buscar y anotar documentos desde el visor de PDF. 
 
Para abrir un documento con el Visor de PDF solo hay que hacer clic dos veces sobre el mismo 
desde la ventana central del Escritorio. Si no aparece el icono de PDF, es que no tenemos 
disponible el texto completo. 
 

 
 
 
 



 

 

Otros iconos que podremos encontrar son los siguientes: 
 

 La estrella nos indica que es un documento marcado como Favorito (Favourite 
document) 

 El punto verde marca el documento como No Leído y el punto gris como Leído. 
 

 
Cuando buscamos por palabra claves o frases en un documento estas aparecerán destacadas. A 

continuación incluimos una imagen de la Barra de herramientas del visor de PDF. 

 
 
Usaremos el botón Notas para hacer anotaciones en cualquier lugar del documento. 
 
Para hacer Notas detalladas usaremos la pestaña “Notes” que aparece junto a la opción “Details” 
en el panel de detalles y que está al lado del visor de PDFs. Podemos probar a Añadir una Nota y 
ver que efectivamente se recupera (Ej.: reactivo químico o peces). 
 
 

 
 
Contents y Enrichments: Esta opción es muy interesante ya que desde Contents 
automáticamente nos muestra el índice del artículo y desde Enrichments nos mostraría  figuras, 
tablas, etc. A continuación una imagen nos muestra cómo se visualiza. ¡Ojo! La opción 
“Enrichments” ha desaparecido en las últimas actualizaciones de Mendeley.  



 

 

 
 

Y además podremos ir directamente a una parte del documento desde el sumario que nos 
presenta Contents. 
 

 
 
Una de las últimas novedades es que Mendeley Web ya permite incluir subrayados y anotaciones 
en sus documentos en PDF. Por tanto, esto supone que los subrayados y anotaciones que se 
habían creado en origen desde Desktop también aparecen en la versión web y viceversa. 

 



 

 

2.5. Buscar e importar nuevo contenido 
 

Literature Search: 

 
 

 
 
Desde esta opción podemos buscar y añadir documentos directamente (simplemente arrastrando 
el documento que nos interese a una carpeta) desde los resultados que obtengamos en el 
Catálogo de publicaciones de Mendeley que aparecerán en la ventana central de la versión 
escritorio. Pueden usarse Operadores para acotar la búsqueda. Podemos incorporar a nuestra 
base de datos las referencias obtenidas picando Save Reference o arrastrándola directamente a la 
carpeta que nos interese.  

Emplea los Operadores de Búsqueda avanzada para refinar la búsqueda [Ejemplo: buscar por 
Diatoms AND applications]. 
   
En caso de no marcar ninguno de esos campos, la búsqueda se realiza en todos los campos del 
registro, incluyendo las Notas que se pueden añadir en la zona derecha de la pantalla, 
Details/Notes/Contents, pero no en las notas tipo post-it añadidas por el usuario en el pdf desde 
el editor de documentos. Asimismo se busca en el texto  completo de los documentos 
disponibles. 
 
 

 
Cuando se encuentra una aparición del término elegido, el sistema nos muestra  los registros  
mostrando la palabra resaltada. 
 
 
 
 
 



 

 

 
 

 
 
Hay un tercer método de incorporación de referencias, picando un registro o una selección de 
ellos en la columna central y el icono Related, o el botón derecho del ratón y seleccionando 
Related. El sistema efectúa una búsqueda en la base de datos de Mendeley y nos muestra los 
registros encontrados con la palabra resaltada. 
 

Importante: Para aprender más sobre las opciones de búsqueda, consulte el siguiente enlace en 
inglés. Es muy útil porque proporciona distintos ejemplos de búsqueda. 

http://support.mendeley.com/customer/portal/articles/227955 
 
 
 
Importar contenido con “Web Importer”: 
 
Mendeley permite guardar directamente de forma online contenido desde una gran cantidad de 
fuentes de información y bases de datos académicas. Para ello debemos instalar este componente 
en nuestros Marcadores. Toda la información en el siguiente enlace: 
https://www.mendeley.com/import/ 
 
Cuando vayamos a guardar los documentos, nos pedirá el sistema que nos autentifiquemos en la 
versión Web de Mendeley. Una vez que el proceso haya concluido (puede tardar más o menos 
dependiendo del número de resultados y si además vamos a guardar los PDF), nos confirmará que 
se ha realizado correctamente. Creamos una carpeta y guardamos los documentos desde la 
versión Web y después podemos comprobar que efectivamente nos aparece en la versión 
escritorio. Ambas se sincronizan cuando nos desconectemos de la versión Web y volvemos a 
entrar. 
 
 
 
 



 

 

Imagen de ejemplo: Web Importer y PubMed 
 

 
 
 
  

 

 
 

La mayoría de las fuentes de información funcionan con Web Importer. Destacamos las 
siguientes: 
 
PubMed, BioMedCentral, arXiv, EBSCO, IEEE Xplore, Google Scholar, SCOPUS, ISI, OvidSP, Springer 
Link … 



 

 

Cuando no sea posible salvar directamente las referencias con Web Importer, se salvan los datos 
en  ficheros estándar, RIS o BibTex, que llevan banderas separadoras  de campos, legibles al 
importar por Mendeley Desktop. 

Además los sitios Webs se podrían almacenar en Mendeley con Web Importer (Practicar con  el 
recurso: GenBank). 
 
 

 
 
 
 
Cómo usar “Watch Folder” (Carpeta monitorizada): 
 
Julio Alonso Arévalo la denomina “Carpeta inteligente”. Esta carpeta nos permitirá importar y 
guardar documentos en PDF simplemente arrastrándolos hacia una carpeta previamente 
establecida que marcamos como Watch Folder. Para ello tendremos que seleccionar la opción 
desde el menú “Add files” de la barra de herramientas principal y explorar la carpeta que 
contiene todos los documentos de nuestro interés. Todos los documentos que almacenemos en 
dicha carpeta serán añadidos por Mendeley a nuestra biblioteca y el gestor extraerá de cada uno 
de ellos datos como título, autor y revista. Veamos un ejemplo de cómo añadir una carpeta 
monitorizada en las dos imágenes siguientes. 
 
 

Importante: Las bases de datos del CSIC y DIALNET trabajan con RIS. Fama Plus funciona 
directamente con el botón “Save to Mendeley”. Desde Fama Clásico con el botón directo de 
exportar a Mendeley se puede guardar una referencia en Mendeley Escritorio. 

 

En relación a la base de datos del ISI conocida como Web of Science, con el Web Importer 
solo conseguiremos llevarnos los primeros 20 resultados. La alternativa de exportar en 
formatos .bib o RIS, sólo está disponible si seleccionamos la "Colección principal de Web of 
Science". 

 

Las bases de datos de Proquest como ERIC o ABI INFORM no funcionan con Web Importer. La 
alternativa es también el formato estandarizado RIS. 

 

La base de datos PeDRO (Fisioterapia basada en la evidencia) del área de Centros de Salud, 
funciona con TXT. http://guiasbus.us.es/c.php?g=159330&p=1839904#s-lg-box-wrapper- 
6687521 



 

 

 
 

 
 

2.6. Escribir y citar: cómo formatear un manuscrito 
 

El Plugin de Cita permite trabajar directamente con tu manuscrito en el procesador de texto 
utilizando para ello tu base de datos de Mendeley. De forma que podrá formatear un trabajo 
completo, incluyendo citas en el texto y generando de forma automática la bibliografía en pocos 
segundos. 

 
 
 
 



 

 

Instalar el Plugin de Citación: 
 

 
 
 
 
Para instalar el Plugin debemos tener abierto el Escritorio de Mendeley e ir a la barra de 
herramientas principal. Hacemos clic en “Install MS Word Plugin” o también podemos escoger 
instalarlo en Open Office si es el caso. Si el plugin se ha instalado correctamente, te aparecerá una 
ventana con un mensaje de confirmación. 
 
Podemos visualizar las referencias  de la parte central de la pantalla  de dos maneras, como Tabla 
o como Cita. 
- La vista como tabla es cómoda y ágil para trabajar con las referencias. 
- En la vista como Cita, se nos muestran tal y como aparecerían las referencias en una bibliografía 
y, además, en el estilo de cita, Citation Style, que hayamos seleccionado. Podemos modificarlo en 
cualquier momento y el gestor reformateará todas nuestras referencias. Mendeley maneja los 
estilos de las revistas e instituciones más importantes. Asimismo dispone de una utilidad de 
generación y modificación de estilos. 
 



 

 

 
 
 
 
Escoge o selecciona tu estilo de cita: 
 
Para ello, hay que hacer clic en View → Cita on Styles → More Styles. 
 
La forma de citar un documento cambiará con el estilo bibliográfico elegido. 
 
En caso de que necesites Títulos abreviados de revistas en el estilo de citación y éste no lo incluya, 
se puede utilizar para ello el Editor avanzado (Ver p. 23). 



 

 

 
 

 
 
Mendeley dispone de miles de estilos bibliográficos de las revistas más importantes y de 
Instituciones de todo el mundo. 
 
Para formatear un documento, sólo tenemos que hacer clic en la barra de herramientas que 
aparece en nuestro procesador y le damos a “Insertar citar” y buscamos el documento que 
queremos citar. Te permite además insertar citas desde My Library o desde un Grupo concreto. 
En la imagen que incluimos a continuación podemos ver donde se encuentra el acceso a nuestro 
Plugin una vez que lo hemos instalado. 
 



 

 

 
 
También debemos destacar dos opciones en la versión escritorio relacionadas con el Plugin para 
formatear manuscritos y que podremos activar desde la pestaña View > Citation Style: 
 
- En algunos casos incluirá las URLs en la Bibliografía. Podremos quitar estos enlaces 
indicando al sistema que sólo lo aplique a Páginas Web. 
- Podemos indicar que el lenguaje para las citas y Bibliografía sea el Español. 

 
 
 

Es importante conocer la opción MERGE CITATIONS que solo se activa cuando seleccionamos dos 
citas a fusionar. Para aprender más sobre esta opción visualiza el siguiente tutorial: 

 https://youtu.be/Ld_iFn38Ccw?list=PL-nGR3dgPXExCiBuifCmApHo0WpTMQgM1 
 
 
Citar directamente un documento desde tu Biblioteca: 
 
Desde Ver > como Citation Style, podremos directamente copiar y pegar la referencia. 



 

 

Para usuarios avanzados, Editor del Estilo de cita: 
 
Permite editar el estilo de citas. Este editor de código abierto ha sido producido en colaboración 
con Columbia University Libraries. (Ojo: no se editan directamente sino que se hace una copia de 
ese nuevo estilo creado). Se trata de un aspecto del gestor que Mendeley reconoce estar 
desarrollando. De hecho, el editor de estilo avanzado utiliza un lenguaje de programación que es 
complejo, pero nos permite hacer pequeñas variaciones en el formato de la referencia, como por 
ejemplo: cambiar a negrita, cursiva, subrayar, etc. A continuación incluimos un enlace a un  
 
 
Tutorial sobre el Editor avanzado. 
 
https://www.youtube.com/watch?v=ajYghxTZCxs&index=8&list=PL- 
nGR3dgPXExCiBuifCmApHo0WpTMQgM1 
 
 
No obstante, en Mendeley hay disponibles variaciones sobre un mismo estilo, como podemos ver 
en la siguiente imagen cuando buscamos el estilo Vancouver. Normalmente no tendremos que 
crear nuestro propio estilo de citación, salvo en contadas ocasiones, ya que Mendeley nos da la 
opción de elegir entre una gran cantidad de estilos bibliográficos. 
 

 



 

 

2.7. Cómo formatear una Bibliografía sencilla 
 

Tenemos que seguir los siguientes pasos: 
 
- Abrimos una carpeta y en Vista escogemos Library as Citations. 
- Nos posicionamos en la primera referencia. 
- Edit > Select all 
- Edit > Copy as – Formatted Citation. Desde File > Send by e-mail. 
 
 
 

 

Accede al Tutorial “Mendeley: formatear una Bibliografía sencilla” 
 
https://www.youtube.com/watch?v=okygILSr0dE&index=12&list=PL- 
nGR3dgPXExCiBuifCmApHo0WpTMQgM1 
 
 
 
 

Accede a nuestro Tutorial de YouTube “Mendeley: enviar referencias por e-mail” 
 
https://www.youtube.com/watch?v=O9Zy1etEM2I&index=13&list=PL- 
nGR3dgPXExCiBuifCmApHo0WpTMQgM1 
 
 

2.8. Sincronizar los distintos dispositivos 
 

Mendeley es multiplataforma y por tanto, funciona con varios sistemas operativos. La opción 
Sync te permite sincronizar tu trabajo de investigación a través de los distintos dispositivos que 
utilices ya sea ordenador personal, ordenador de trabajo, IPhone o IPad1. Es muy interesante  la 
aplicación para IOS. También está disponible para Android desde Google Play. 
 

1 Compatibilidad del App de Mendeley para dispositivos móviles: Requiere iOS 6.0 o superior. Es 
compatible con iPhone, iPad, and iPod. Optimizado para iPhone 5. 



 

 

 
Funcionamiento: 
 
Una vez se ha hecho clic en Sync desde el Escritorio de Mendeley, todos tus datos almacenados 
en el gestor estarán guardados de forma segura en los servidores de Mendeley y podrás acceder a 
ellos desde cualquier maquina o dispositivo móvil que utilices. Igualmente ocurrirá con las Notas 
en los grupos si se activa la opción de sincronizar. 
 

Es importante saber que existe una política de Privacidad por parte de Mendeley y la compañía 
se compromete a no publicar ni compartir datos privados o datos de las investigaciones que cada 
usuario esté realizando, a no ser que explícitamente se haya decidido compartir con otros 
investigadores a través de las distintas opciones disponibles en Mendeley. 
 
https://www.mendeley.com/privacy/ 
 
 
 
 
2.9. Crear Grupos desde la versión Escritorio 
 

Para crea un grupo, usamos la opción Edit > New Group de la versión Escritorio, tal y como vemos 
en la imagen adjunta (o directamente desde Mi Bibliotecas botón derecho del ratón New Group). 
También desde Grupos > Create Group. 
 
 
 

 



 

 

 
  

Podemos añadir en cualquier momento detalles al Grupo Privado desde Edit Settings en la 
versión escritorio (este tipo de grupo se distingue porque tiene un icono que representa una 
especie de Caja fuerte). Si hacemos click en Editar la configuración adicional de (Additional Group 
Settings), nos va a llevar a la Versión Web.  

 
 
Si compartimos Documentos en PDF en un grupo privado y añadimos Notas sobre el mismo, los 
miembros del grupo recibirán estos avisos en forma de Anotaciones, como podemos ver en la 
imagen adjunta. Cada integrante del grupo será identificado por el sistema con un color distinto. 



 

 

 
 

  
Si guardamos una referencia en un Grupo Público, no se comparte el PDF. 
 
 
Check for Duplicates. Control de duplicados en la totalidad de documentos o en una carpeta 
marcada. (Seleccionar carpeta /Tools/ Check for duplicates). 
 
 

 
 
 
 
 
 
 
 
 
 
 



 

 

3. MENDELEY: VERSIÓN WEB 
 

Para acceder a Mendeley Web, hay que autentificarse en http://www.mendeley.com/ en la caja 
que aparece en la parte superior derecha y podremos ver directamente nuestras referencias en la 
página web de Mendeley. 
Es similar a una red social académica y el perfil cumplirá mejor su función si se aporta toda la 
información necesaria para mostrar la trayectoria profesional y académica. Si hacemos clic en 
nuestro nombre accedemos a la información del perfil. Es importante conocer las políticas de 
copyright de tus publicaciones antes de compartirlas. 

 

En Library aparecen los mismos documentos que tenemos en la Versión Escritorio. 

Las opciones principales que nos encontramos son: 

 
 
1. Feed: para estar al día de las noticias de nuestros contactos y lo que publican. 
 
2. Settings & Privacy: Para gestionar tu cuenta personal en Mendeley. Desde aquí además podrás 

desconectarte (logout). 
 
3. Support: Acceso al Foro de Mendeley. Muy útil para resolver problemas. 
 
 



 

 

 
 
 
 
 
 

3.1. Biblioteca Web (Web Library) 

Tu Biblioteca vía Web es idéntica a la Biblioteca de la versión escritorio, permitiendo que se pueda 
acceder desde cualquier lugar a través de Internet. 

 
 
3.2. Colaborar y compartir en grupos 
 

Como ya hemos visto en la versión escritorio, esta opción permite compartir referencias/PDF, 
discutir temas, comenzar un debate, seguir el progreso de un Proyecto a lo largo del tiempo, etc. 

Antes Mendeley recomendaba la Gestión de Grupos desde la Versión Escritorio pero actualmente 
se puede realizar desde la versión Web.  
 
Los tipos de grupos que podemos crear en Mendeley son: 
 

 Privado (Private) – Para compartir referencias y textos completos. Solo los miembros 
del grupo pueden verlos. Esta opción es óptima para compartir en privado. 
 Solamente Invitado (Invite-only) – Para compartir sólo referencias. Esta opción es 
óptima para compartir referencias y listas de lectura. Los usuarios de Mendeley pueden 
solamente seguir el grupo. 



 

 

 Abierto –Para compartir referencias solamente. Cualquier usuario de Mendeley puede 
ser miembro del grupo o seguirlo. Esta opción es óptima para listas de lectura que sean seguidas 
por mucho público. 
 
Para seguir la actividad de todos los grupos, usaremos la pestaña Group desde la versión Web. 
 
 
 
3.3. Añadir documentos via Web 

Desde Mi Biblioteca en la Web tenemos un botón directo para añadir documentos como 
podemos ver en la siguiente imagen. 

 



 

 

 
 

4. Recursos Web sobre Mendeley 

 
 
Guía de Mendeley de la BUS  http://guiasbus.us.es/mendeley 
 

Guía de Mendeley de la BUS. FAQs  http://guiasbus.us.es/faqsmendeley/faqs 
 

                                       Help Guides de Mendeley 
                                       https://www.mendeley.com/guides?dgcid=Mendeley_Desktop_Help-menu-Help-guides&desktop=1.19.2-Windows-x86-HelpMenuAction 
 

Lista de Reproducción “Mendeley: gestor de referencias y documentos" / Canal YouTube CRAIUlloa 
https://www.youtube.com/playlist?list=PL-nGR3dgPXExCiBuifCmApHo0WpTMQgM1 
 
 

Taller de Mendeley. Fernández Palomar, María del Carmen … [et al.] 
http://nrobinsongarcia.files.wordpress.com/2013/11/teorc3ada-de-mendeley.pdf 
 

Podcast Planeta Biblioteca 2014/11/12. Mendeley. Gestor de referencias sociales 2.0 por Julio Alonso Arévalo 

http://www.ivoox.com/planeta-biblioteca-2014-11-12-mendeley-gestor-referencias- sociales-audios-mp3_rf_3715628_1.html 
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